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2.2 GENERAL MODELLING ASPECTS

For each new project to be analyvsed it 15 important to create a geometry model first. A
geometry model 15 a 2D representation of a real three-dimensional problem and consists
of points, lines and clusters. A geometry model should include a representative division
of the subsoil info distinct soil layers, structural objects, construction stages and
loadings. The model must be sufficiently large so that the boundanes do not influence
the results of the problem to be studied. The three types of components 1n a geometry

maodel are described below in more detail.

Painis:

Points form the start and end of lines. Points can also be used for the
positicming of anchors, point forces, point fixsties and for local refinements of

the finite element mesh.

Lines are used to define the physical boundaries of the geometry, the model
boundaries and discontinuties in the geometry such as walls or shells,
separations of distinet so1l layers or construction stages. A line can have several
functions or properties.

Clusters:

Clusters are areas that are fully enclesed by lines. PLAMIS automatically
recogmises clusters based on the mmput of geometry lines. Within a cluster the
s01l properties are homogenecus. Hence, clusters can be regarded as parts of
soil layers. Actions related to clusters apply to all elements in the cluster.

After the creation of a geometry model, a finite element model can antomatically be
generated, based on the composition of clusters and lines in the geometry model In a
finite element mesh three types of components can be wdentified, as described below.




Elements:

Nodes:

During the generation of the mesh, clusters are divided into triangular elements.
A choice can be made between 15-node elements and 6-node elements. The
powerful 15-node element provides an accurate calculation of stresses and
failure loads. In addition. 6-node triangles are available for a quick calculation
of serviceability states. Considering the same element distribution (for example
a default coarse mesh generation) the user should be aware that meshes
composed of 15-node elements are actually much finer and much more flexible
than meshes composed of 6-node elements, but calculations are also more tume
consunung. In addition to the triangular elements, which are generally used to
model the soil, compatible plate elements, geogrid elements and interface
elements may be generated to model structural behaviour and soil-structure
mteraction.

A 15-node element consists of 15 nodes and a 6-node triangle 15 defined by 6
nodes. The distribution of nodes over the elements 15 shown in Figure 2.1
Adjacent elements are connected through their commeon nodes. Durning a finite
element calculation. displacements (i, and u,) are calculated at the nodes.
Nodes may be pre-selected for the generation of load-displacement curves.

Stress points:

In confrast to displacements, stresses and strains are calculated at individual
Gaussian infegration points (or stress points) rather than at the nodes. A 15-
node triangular element contams 12 stress pomts as indicated in Figure 2 1a
and a 6-node tnangular element contains 3 stress poimnts as indicated mn Figure
2.1b. Stress pownts may be pre-selected for the generation of stress paths or
stress-strain diagrams.



® stress points

Figure 2.1 Nodes and stress points
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General settings - General tab sheet
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LESSON 1

SETTLEMENT OF A CIRCULAR
FOOTING ON SAND



GEOMETRY

Figure 3.1 Geometry of a circular footing on a sand layer
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Figure 3.4 Dimensions tab sheet of the General settings window

Hint: In the case of a mustake or for any other reason that the general settings need
to be changed. you can access the General settings window by selecting the
General settings option from the File menu.




Mispositioned points and lines can be modified or deleted by first choosing
the Selection button from the toolbar. To move a point or line, select the
point or the line and drag it to the desired position. To delete a pont or a
line, select the point or the line and press the <Delete> button on the
keyboard.

Unwanted drawing operations can be removed by pressing the Undo button
from the toolbar or by selecting the Undo option from the Edit menu or by
pressing <Ctrl=<Z> on the keyboard.

Lines can be drawn perfectly horizontal or vertical by holding down the
<Shift> key on the keyboard while moving the cursor.

The full geometry model has to be completed before a finite element mesh
can be generated. This means that boundary conditions and model
parameters must be entered and applied to the geometry model first.
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Figure 3.5 Geometry moedel in the Input windeow




Hint:

The Standard fixities option 1s suitable for most geotechnical applications. It
1s a fast and convenient way to input standard boundary conditions.

The mput value of a prescribed displacement may be changed by first
clicking on the Selection button and then double-clicking on the line at
which a prescribed displacement 1s applied. On selecting Prescribed

displacements from the Select dialog box., a new window will appear in
which the changes can be made.

The prescribed displacement 1s actually activated when defining the
calculation stages (Section 3.2.2). Imit1ally it 1s not active.




Table 3.1 Material properties of the sand layer

Parameter

Name

Value

Material model
Type of material behaviour
So1l unit weight above phreatic level

Soil unit weight below phreatic level

Model
Ivpe
Vunsat
Ysat

Mohr-Coulomb
Dramed

17.0

20.0

Parameter

Name

Unit

Permeability in horizontal direction
Permeability in vertical direction
Young's modulus (constant)
Poisson's ratio

Cohesion (constant)

Friction angle

Dilatancy angle

m/day
m/day
kN/m”

kN/m’
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PLAYMIS distinguishes between a project database and a global database of
material sets. Data sets may be exchanged from one project to ancther using
the global database. The data sets of all lessons in tlus Tutorial Manual are
stored mn the global database during the installation of the program. To copy
an existing data set, click on the <Global> === button of the Material Sets
window. Drag the appropriate data set (in this case “Lesson 1 sand”™) from
the tree view of the global database to the project database and drop it there.
Now the global data set 15 available for the cumrent project. Simularly, data
sefs created in the project database may be dragged and dropped in the
global database.

Existing data zet: mavy be changed by opeming the material zets window,
selecting the data set to be changed from the tree view and clicking on the
~Edit> button. As an alternative, the material sets window can be opened by
double clicking a cluster and clicking on the <Change> button behind the
Material sef box in the properties window. A data set can now be assigned
to the corresponding cluster by selecting it from the project database tree
wview and clicking on the <Applv> button.

The program performs a consistency check on the material parameters and
will give a warning message in the case of a detected inconsistency in the
data.
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Figure 2.3 Axisymmetric finite element mesh of the geometry around the footing




The <Update>> button must always be used to return fo the geometry mput,
even 1f the result from the mesh generation 15 not satisfactory.

By default, the Global coarseness of the mesh 15 set to Coarse, which 13
adequate as a first approach in most cases. The Global coarseness setting
can be changed 1n the Mesh menu. In additional options are available to

refine the mesh globally or locally.

At this stage of mput 1t 15 still possible to modify parts of the geometry or to
add geometry objects. If modifications are made at thus stage, then the finite
element mesh has fo be regenerated.
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Fizure 3.9 Imtial stress field in the geometry around the footing

The E,procedure may onlv be used for honzontally layersed geometries
with a hornzontal ground swface and, 1f applicable, a honzontal phreatic
level. See Appendix A or the Reference Manual for more information on the
Kqprocedure.

The default value of K, 15 based on Jaky's formula: K, = 1-simg. If the value
was changed, the default value can be regaimed bv entering a negative value

for K.
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Figure 3.10 The Calculations window with the General tab sheet
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Figure 3.13 The calculations mfo windowr

Hint: The ={Calculate== button 15 only wisible 1if a calculation phase that 15 selected
for execution 15 focused m the list.




Calculation phases may be added, mserted or deleted using the <Next>
<Insert> and <Delete> buttons half way the Calculations window.

Check the List of calculation phases carefully after each execution of a
(series of) calculation(s). A successful calculation 1s indicated mn the list with
a green check mark (V) whereas an unsuccessful calculation 1s indicated
with a red cross (). Calculation phases that are selected for execution are

indicated by a blue arrow (—).

When a calculation phase 1s focused that 15 mdicated by a green check mark
or a red cross, the toolbar shows the <Output™> button, which gives direct
access to the Output program. When a calculation phase 1s focused that 15
mndicated by a blue arrow, the toolbar shows the <Calculate> button.




g e
Errome oial deplacararid 10 m
e plarreris. e o 2 B0 bare)

A L TR B

Figure 3.14 Deformed mesh




Hint: Inadditon to the total displacements, the Deformations menn allows for the
presentation of Incremental displacements. The meremental displacements

are the displacements that occurred within one calculation step (m this case
the final step). Incremental displacements may be helpful m visualizsng &n
eventual fatlure mechanism.

The plots of stresses and displacements may be combimed with geometrical
features, as avatlable m the Geometry menn.




Figure 315 Prncipal stresses




Table 3.2, Material properties of the footing

Paramester

Value

=
=

Normal stiffness
Flexural rigidaty
Equivalent thickness

Weight

Poizzon'

5 1atio

5107
8500

0.143
0.0

e T

= 5, Im [1:] !

o

0.0

Hint:

If the Material Sets window 1s displayed over the footing and hides if, move
the window to another position so that the footing 15 clearly visible.

Hint:

The equivalent thickness 15 automatically calculated by PLANIS from the
values of EA and EI It cannot be entered by hand.




Hint:

Regeneration of the mesh results 1 a redistnbution of nodes and stress
pownts. In general, existing stresses will not comespond with the new

posttion of the stress pomnts. Therefore 1t 15 important to regenerate the mitial
water pressures and 1nitial stresses after regeneration of the mesh

Multiple (sub-)windows may be opened at the same time in the Output
program. All windows appear in the list of the Window menu. PLANIS
follows the Windows standard for the presenfattion of sub-windows
(Cascade, Tile, Minimize, Maximize, etc). See your Windows manual for a
description of these standard possibilities.
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The Curve seifings window may also be used to modify the
presentation of a curve.

atiributes or

Figure 3.17 Load-displacement curve for the footing




To re-enter the Curve generation window (1n the caze of a mistake, a desired
regeneration or m:n::'lifu"ﬂti-'nu} vou can click on the Change curve seffings
button from the toolbar. As a result the Cwrve seftings window appears. on
winch you :.Ju:nl.l]-::l ]1||r on the =Fegenerate™ bution. "'.l'emrr'e.v. you may
open the Curve se r window by selecting the Cwrve option from the

Format menm.

The Frame seffings window may be used to modify the rEt'j.1.1-Ir of the
frame. This window can be opened by clicking on the Change frame setfings
button from the toolbar or =E1E-:tlu_g the Frame oplion from the Format
e,




LESSON 2

SUBMERGED CONSTRUCTION OF
AN EXCAVATION



3 ENmm

‘hﬁ:ﬂiﬁﬂ'ﬂﬂﬂﬂﬁ / /
/ o e axca -.'ETE":[ I:].,"-,:. /

Figure 4.1 Geometry model of the situation of a submerged excavation




Withmn the geometry mnput mode 1t 15 not sinictly necessary to select the
buttons mn the toolbar i the order that they appear from left to nght. In this
case, 1t 13 more convenlent to create the wall first and then enter the
separation of the excavation stages by means of & Geomeny line.

When creatmg a pomt very close to a lme, the pont 15 usually snapped onto
the line, because the mesh generator canmot handle non-comcident points
and nes at a very amall distance. This procedure also stmphfies the mput of
pomnts that are intended to lie exactly on an exsting line.

If the pointer 13 substantially mspositoned and mstead of snappmng onto an
existimg powt or line a new 1solated point 15 created, this pomt may be
dragged (and snapped) cnto the existiing pomt or lme by using the Selection
button.

In zeneral, only one pomt can exist at a certam coordnate and only one lme
can exist between two pomts. Comeidng points or lines will automatically
be reduced to smgle pomnts or lmes. The procedure to drag peints onto
ex1sting points may be used to elinunate redundant pomts (and limes).




The selection of an interface 1s done by selecting the corresponding
geomefry line and subsequently selecting the corresponding interface
(positive or negative) from the Selecr dialog box.

Interfaces are indicated as dotted lines along a geometry line. In order to
identify interfaces at either side of a geometry line., a positive sign (&) or
negative sign (&) 1s added. This sign has no physical relevance or influence
on the results.

A fixed-end anchor i1s represented by a rotated T with a fixed size. This
object 1s actually a spring of which one end is connected to the mesh and the
other end 1s fixed. The orientation angle and the equivalent length of the
anchor must be directly entered in the properties window. The equivalent
length i1s the distance between the connection point and the position in the
direction of the anchor rod where the displacement is zero. By default, the
equivalent length 1s 1.0 unit and the angle 1s zero degrees (1.e. the anchor
points in the positive x-direction).

Clicking on the 'middle bar' of the corresponding T selects an existing fixed-
end anchor.
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Figure 4.2 Geometry model in the Input window




Table 4.1. Material properties of the sand and clay layer and the interfaces

Parameter Name | Clay Sand
layer layer

Material model Model | Moht- Mohr-
Coulomb | Coulomb

Type of material behaviour Iype Drained | Drained | -

Soil unit weight above phreatic level | Yumsar 16 17 kN/my’

Soil unit weight below phreatic level | % 18 20 KN/m’

Permeability in hor. direction k, 0.001 1.0 m/day
Permeability in ver. direction k, 0.001 1.0 m/day
Young's modulus (constant) E. 10000 40000 kN/m’
Poisson's ratio 0.35 0.3 -
Cohesion (constant) o 5.0 1.0 kN/m’
Friction angle 25 32 :

Dilatancy angle . 0.0 2.0

Strength reduction factor inter. 0.5 0.67




Instead of accepting the default data sets of interfaces. data sets can directly
be assigned to interfaces in their properties window. This window appears
after double clicking the corresponding geometry line and selecting the
appropriate interface from the Selecr dialog box. On clicking the <Change=
button behind the AMarerial ser parameter, the proper data set can be selected
from the Material sefs tree view.

In addition to the Material serf parameter in the properties window. the
Virtual thickness facror can be entered. This is a purely numerical wvalue,
which can be used to optimise the numerical performance of the interface.
Non-experienced users are advised not to change the default value. For more
information about interface properties see the Reference Manual.

Table 4.2. Maternial properties of the diaphragm wall (Plate)

Parameter Name WValue Tt

Tvype of behaviour Material tvpe Elastic
Normal stiffness EA 7.5-10° kN/m

-7,
6 KNm-~/m

Flexural rigidity ET 1.0-10
Equivalent thickness d 1.265 m
Weight W 10.0 kN/m/m

Poisson's ratio v 0.0 -

Hint: The radio button Rigid in the S#rength box 1s a direct option for an interface
with the same strength properties as the soil (R, = 1.0).




Table 4.3. Material properties of the strut (anchor)

Parameter Name Value

Type of behaviour Material tvpe Elastic
Normal stiffness EA 2:10°
Spacing out of plane L, 5.0

Maximum force Foox comp 1-10F

F o tens 1-10%°

The mesh settings are stored together with the rest of the mput. On re-
entering an existing project and not changing the geometry configuration
and mesh settings, the same mesh can be regenerated by just clicking on the
Generate mesh button on the toolbar. However. any slight change of the
geometry will result in a different mesh.

The Reset all option from the Mes/i menu may be used to restore the default
setting for the mesh generation (Global coarseness = Coarse and no local
refinement).




When a project is newly created, the water weight 1s presented directly on
entering the Groundwater mode. On re-entering an existing project the input
of the water weight can be accessed by selecting the Water weight option
from the Geomefry menu in the Groundwater mode.

To create an accurate pore pressure distribution in the geometry. an
additional geometry line can be included corresponding with the level of the
groundwater head or the nosition of the ohreatic level in a problem.

An existing phreatic level may be modified using the Selection button from
the toolbar. On deleting the General phreatic level (selecting it and pressing
the <Del> key on the kevyboard), the default general phreatic level will be
created again at the bottom of the geometry. The graphical mput or
modification of phreatic levels does not affect the existing geometry.

Inactive clusters are white, just like the background. whereas active clusters
have the colour of the corresponding material set. Inactive structural objects
are grey, whereas active structures have the basic colour as used during the
creation of the geometry model.




The Staged construction option is not only intended to simulate excavations
or constructions, but it can also be used to change the water pressure
distribution, to change material properties (to simulate soil improvement, for
example) or to improve the accuracy of previous computational results.

You can also enter or change the values of the load at this time by double
clicking on the load and entering a value. If a load 1s applied on a structural

object such as a plate, load values can be changed by clicking on the load or
the object. As a result a window appears in which you can select the load.
Then click on the <Change> button to modify the load values.

Hint:

Note that in PLAXIS the pore pressures are not automatically deactivated
when deactivating a soil cluster. Hence, 1n this case, the water remains in the
excavated area and a submerged excavation 1s simulated.
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Figure 4.3 The Calculations window with the Parameters tab sheet




To select the desired nodes, 1t may be convenient to use the Zoom in option
on the toolbar to zoom nto the area of interest.

Hint: The Staged construction window 1s similar to the Inifial conditions window
of the Input program. The main difference 1s that Inifial conditions 1s used to
create an 1mitial situation, whereas Staged construction 1s used as a type of
loading.




Figure 4.4 Deformed mesh after submerged excavation
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Figure 4.6 Bendings mmoments i the wwrall

Hint:

The Window menu may be used to switch between the window with the
forces in the wall and the stresses in the full geometry. This menu may also
be used to Tile or Cascade the two windows, which i1s a common option in a
Windows environment.
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Figure 4.7 Load-displacement curve of deflection of wall




LESSON 3

UNDRAINED RIVER EMBEDMENT
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Figure 5.1 Geometry of the river embankment subjected to a changing water level
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Figure 5.2 Geometry model of the river embankment project




Material sets

Three material layers are adopted for the soil. The properties are given in Table 5.1.

Table 5.1. Material properties of the river embankment and subsoil

Parameter

Name

Clay

Peat

Sand

Material model

Type of behaviour

Soil unit weight above p.L
Soil unit weight below p.L
Horizontal permeability
Vertical permeability
Young's modulus
Poisson's ratio

Cohesion

Friction angle

Dilatancy angle

Model
Type

J'J?E.?I'S ar

MC

Undr.

16
18

MC
Undr.
8
11.5
0.01
0.001
500
0.35
7.0

MC
Dramned
17

20

1.0
1.0
20000
0.3
1.0
35

0.0

KN/m’
kN/m?
m/day
m/day
kN/m’

kN/m?

-

-




Figure 5.3 Finite element mesh of nver embankment project

Hint: If initial stresses were generated by mistake, they can be reset by entering
the Ky-procedure. entering a value of IMweight = 0 and pressing the
<Generate> button.




Hint:

Since the inifial stresses are not subject to undramed behaviour, it 1s
important that undrained behaviour 1s disabled during gravity loading. This
can be done by selecting Ignore undrained behaviour i the Parameters tab
sheet of the Calculations window.

In contrast to the Kq-procedure, the calculation of imitial stresses by means
of gravity loading results in displacements. These displacements are not

realistic, because the embankment 1s modelled as 1t appears in reality and
the calculation of the initial stresses should not influence the displacements
computed later in the analysis. These unrealistic displacements can be reset
to zero at the start of the next calculation phase by selecting Reset
displacements to zero in the next phase.
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Figure 5.6 Phreatic level for sand laver

Hint:

The phreatic level corresponding to a particular cluster 1s indicated in red as
soon as the cluster 1s selected. Clicking outside the geometry results in an
indication of the general phreatic level. If a cluster 1s selected where the
Interpolate... option applies, no phreatic level 1s indicated.
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Hint: A cross section can be drawn perfectly horizontal or vertical by holding
down the <Shift> key while drawing the cross section.
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Figure 5.9 Effective stresses in embankment after the increase of the water level




Figure 5.10 Excess pore pressures after the increase of the water level




LESSON 4

DRY EXCAVATION USING TIE
BACK WALL



eround
anchor

Figure 6.1 Excavation supported by tie back walls

In general. 1t 1s a good habit to extend interfaces around corners of structures
to allow for sufficient freedom of deformation and to obtain a more accurate
stress distribution. When doing so. make sure that the strength of the
extended part of the interface is equal to the soil strength and that the
interface does not influence the flow field. if applicable.
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Figure 6.2 Geometry model of building pit

The extended part of an interface is not used for soil-structure interaction
and should therefore have the same strength as the suwrrounding soil. This
can be achieved with a strength reduction factor R, = 1.0. which is
automatically adopted in the Rigid selection. If necessary, a separate
material data set must be created for the extended part of an interface. In
addition, the extended part of an interface should not influence the flow
field. This 1s achieved by deactivating the interface when generating the
pore pressures.




Table 6.1. Soil and interface properties

Parameter

Name

Fill

Sand

Loam

Material model

Type of material behaviour
So1l vt weight above p 1.
So1l unit weight below p.L
Honzontal permeability
WVertical permeability
Young's modulus
Poisson's ratio

Cohesion

Friction angle

Dilatancy angle

Interface reduction factor

Model
Type
Yimsa
Vear

Rr’urﬂr

MC
Drained
16
20
1.0
1.0
2000
0.30
1.0
30
0.0
0.65

MC
Drained
17

20

0.5
0.5
30000
0.30
1.0
34

4.0

MC
Dirained
17

19

0.1
0.1
20000
0.33
8.0

29

0.0

Table 6.2. Properties of the diaphragm wall (plate)

Parameter

Name

Uit

Type of behaviour
Normal stiffness
Flexural ngidity
Equivalent thickness

Material fype

EAd
ET
d

KMN/m

Y,
EKNm - /‘m
m




Parameter

Name

Value

Weight
Poisson's ratio

8.3
0.15

Table 6.3. Properties of the anchor rod (node-to-node anchor)

Parameter

Name

Talue

Type of behaviour
Normal stiffness
Spacing out of plane
Maximum force

Murerial type
EAd
PRAY, DO

PRax, fens

Elastic

=

10

_lDLE

2
2.5
1
1.10%

Table 6.4. Property of the grout body (geogrid)

Parameter

Name

Talue

Normal stiffness

EA

1-10°
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Phase 3

A pre-stress force 15 exactly matched at the end of a fimshed staged
construction calculation and turned info an anchor force In successive
calculation phases the force 15 considered to be just an anchor force and can

therefore further increase or decrease, depending on the development of the
surrounding stresses and forces.
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Phase 4

Hint: The results of a groundwater calculation can be viewed as Pore pressures,
Flow field and Groundwater head. These options are available from the
Stress menu.

Figure 6.3 Active pore pressure contours resulting from groundwater calculation
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Figure 6.4 Deformed mesh stages (a) to (e)

Figure 6.5 Effective stresses, final stage




Figure 6.&¢ Bending moments in the left diaphragm wall in the final stage




LESSON 5

CONSTRUTION OF A ROAD
EMBEDMENT



Figure 7.1 Situation of a road embankment on soft soil

L
=+

Figure 7.2 Geometry model of road embankment project




Table 7.1. Material properties of the road embankment and subsoil

Parameter

Name

Clay

Peat

Sand

Material model
Type of behaviour

Soil unit weight above
phreatic level

Soil unit weight below

phreatic level
Horizontal permeability
Vertical permeability
Young's modulus
Poisson's ratio
Cohesion

Friction angle
Dilatancy angle

ﬂ-’fﬁ(f{?;
Iype

]’u:ﬂ.'ijﬂ.r

Yeat
k

Ly

E

MC
Undrained
15

18
1-10™
1-10™
1000
0.33
2.0
24
0.0

MC
Undrained
8

11

MC
Drained
16

20
1.0
1.0

0.3
1.0
30
0.0

kN/m’

L3
kN/m
m/day

m/day
P
kN/m”

kN/m’




Closed consolidation boundaries can only be defined by clicking on existing
geometry points. The program will automatically find intermediate
geometry points.

Consolidation boundary conditions must be generated in the boundary nodes
of the mesh. This is done together with the generation of water pressures.
Hence, after introducing or changing consolidation boundaries, always click
on the Generate water pressures button.

Figure 7.4 Excess pore pressures after undrained construction of embankment
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7.6 Development of excess pore pressure under the embankment




The default value of Additional steps in a Phi-c-reduction calculation 1s 100.
In contrast to an Ultimare level calculation, the number of additional steps is
always fully executed. In most Phi-c-reduction calculations, 100 steps are
sufficient to arrive at a state of failure. If not. the number of additional steps
can be mcreased to a maximum of 1000.

For most phi-c-reduction calculations Msf = 0.1 i1s an adequate first step to
start up the process. During the calculation process, the development of the
total multiplier for the strength reduction. XAfsf. 1s automatically controlled
by the load advancement procedure.

Figure 7.7 Shadings of the total displacement increments indicating the most applicable
failure mechanism of the embankment in the final stage
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Figure 7.8 Evaluation of safety factor for three stages of the construction process
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Figure 7.9 Settlements of the foe of the embankment using updated mesh calculation




LESSON 6

SETTLEMENT DUE TO TUNNEL
CONSTRUTION
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Figure 8.1 Geometry of the tunnel project with an indication of the soil lavers




Fil= Edi

[

|:nr\-- rre

0,000 =3 m

Thidnass

H
[« [rke=Tace

T
= -
¥

nel modsl

—

Figure 5.2 Tunnel designer with current tur




Hint: A shell and interface can be assigned directly to all tunnel sections by

clicking on the corresponding buttons at the top of the tunnel window.
A tunnel liming consists of curved plates. The limng properties can be
specified in the material database for plates. Similarly, a tunnel mterface 15

nothing more than a curved inferface.

In the tunnel as considered here the sections do not have a spectfic meaning

since the tunnel limng 15 homogeneons and the tunnel will be constructed at

ofce.
In general. the meaning of sections becomes significant when:

It 13 destred to excavate or construct the tunnel (limng) 1n different stages.
Different tunnel sections have different lining properties.

One would consider hinge connections 1n the limng (hinges can be added
after the design of the tunnel 1n the general drawing area).

The tunnel shape 13 composed of arcs with different radu (for example
NATM tunnels).




Hint: In the Standard fixifies option, a plate that extends to a geometry boundary
that 15 fixed 1n at least one direction obtamns fixed rotations, whereas a plate

that extends to a free boundary obtains a free rotation.

Table 8.1. Material properties of so01l in the tunnel project

Parameter

MName

Clay

Sand

Dp. Clay

Dp.sand

Material model
Material beh.

Seil  wmit weight
above phreatic level
Soil wmit weight
below phreatic level
H. permeability

V. permeability

Y oung's modulus
Increase E
Eeference level
Poisson's ratio
Cohesion

Friction angle
Dilatancy angle
Interface strength

-

Model
Type

*:I.l_ R
LFLE

= 0 = I I o
- e I =
4 4, B &

=
i,

-

nC
Drained
15

MC
drained
16.5

0

1.0
1.0
S0000

0.3
1.0
31

1.0

hC
Dirained
14

nC
dramned
17

21

0
0
1

20000




Table 8.2. Matenial properties of the plates

Parameter

Name

Lining

Pile toe

Building

Type of behaviow
Normal stiffness
Flexural rigidity
Equivalent thickness
Weight

Potzson's ratio

Type
E4
ET

d

W

V

Elastic
1.4.10

[

14310

-
™
L) a™

5.4

0.13

Elastic
2.10°

2.10°
0.210
20
0.

Elastic
1.10"
110"
3464

75

"

0.0

Table §.3. Matenial properties of the anchors

Parameter

Name

File

Material type
Normal stiffness
Spacing between
anchors

Type

E4

-
Lipacing

Elastic
2.10°
1




The contraction of the tunnel lining by itself does not introduce forces in the
tunnel liming. Eventual changes m lining forces as a result of the contraction
procedure are due to stress redistributions in the surmrounding soil or fo
changing external forces.

L™

Figure 8.3 Axial forces and Bending moments in the lining after the second phase.




Figure 8.4 Deformed mesh affer consttruction of the tunnel




Effective stresses after construction of the




Figure 8.6 Amxial forces and bending moments in the liming after the third phase
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